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Introduction

Rational XDE is a new UML development tool designed specifically for developers using Microsoft’s Visual Studio .NET shell, IBM’s Eclipse (an open, extensible tool platform), or IBM’s WebSphere Application Developer. Teams should be able to manage their XDE models in the same way they manage their source code, and this can best be achieved by using XDE with Rational ClearCase, the market leading Software Configuration Management (SCM) tool.

This document provides guidelines for using XDE with Rational ClearCase Unified Change Management (UCM), Rational’s out-of-the-box process that supports SCM best practices. We assume you have some familiarity with XDE, ClearCase, and UCM.
While this document focuses on using Rational XDE with UCM, many of the concepts discussed, such as partitioning and merging models, apply equally well to those readers using ClearCase without UCM.

Differences from Rational Rose

Since many XDE customers will be familiar with Rational Rose, our other UML tool, let’s look quickly at how XDE team support differs from that of Rose.  XDE provides more advanced SCM options than Rose that make it easier to do development while managing your models.  The following are the major capabilities XDE offers:

· Preferences allow you to configure XDE to automatically check out files when they are modified. This means that you don’t need to check out files before making changes—just open the file, start making changes and the file will be checked out for you.

· Preferences allow you to configure XDE to automatically add newly-created files to source control.

· The automatic checkout capability will work with the automatic model/code synchronization tool to automatically check out source files when they are modified due to model changes, or vice versa.

· You can partition a model into finer-grained units than Rose allows. For example, diagrams can be in their own storage units.  Properly partitioning your model into storage units, as discussed later in this document, is critical for successful development of models in large teams.

· XDE supports references between models, allowing you to easily build large applications composed of many models.

· XDE provides the Compare/Merge capability integrated into the XDE application itself, whereas Rose uses a separate application, Model Integrator, to perform merges. Since XDE is performing the merge, you can examine the merge result model in the model explorer as you resolve the conflicts, which you can’t do with Model Integrator.
· The XDE Compare/Merge capability can handle merge conflicts of higher complexity than Rose’s Model Integrator, such as a conflict among three contributors where two contributors have moved a model element to different places and a third contributor has deleted that model element.

· XDE presents each contributor, and the merge result model, in its own tree, instead of using one tree to hold all contributors. This makes it easier to compare the changes of each contributor.

· A new Differences Explorer allows you to look at conflicts organized by difference, or at differences organized by conflict, thus allowing you to work in the manner best suited to the task at hand.

Parallel Development with XDE

There are many ways to use XDE in a team environment and each team will need to decide what works best for them given the way they choose to develop and how work is partitioned among the team. While this document isn’t intended to provide an in-depth discussion of this topic, here are a few considerations to guide your decision.
In general, it is a good idea to partition model elements to minimize concurrent changes.  Concurrent changes occur when two or more users modify the same storage unit at the same time. The second person to check in or deliver the changed unit would overwrite the first person’s changes. Since this is rarely the desired result, the second person should merge the two changed units together. For this reason, ClearCase will automatically detect this situation and will initiate a merge when the second person checks in the changed unit.
If the two sets of changes to the storage unit are in different areas of the model or code, the merge may be considered “trivial”. That is, by examining the storage unit before either of the changes (the base contributor) and the two changed versions of the storage unit, it becomes apparent that each developer has changed different areas of the storage unit and so each developer’s changes can simply be propagated into the new, merged version of the storage unit. However, if there are cases where both developers have made changes to the same place in the storage unit, then those changes are said to conflict and must be resolved by the developer encountering the conflict.

Rational ClearCase recognizes when a merge is required and performs the merge automatically. If changes conflict and must be resolved manually, ClearCase will automatically involve the developer to resolve the conflict. To do so, ClearCase starts the appropriate type manager. For source code, this is typically the Rational cleardiffmrg command. When the storage unit is an XDE model file, or some part of a model, ClearCase will automatically start up Rational XDE so that the developer can resolve the conflict in the model. For this to work properly, ClearCase needs to be told which files are to be handled by the XDE. At present, this requires a one-time set-up operation on each developer machine and each ClearCase server—this set-up operation is described later in this document.
The frequency of concurrent changes can be controlled by how you partition your model into controlled units and by establishing ownership over parts of the system.  However, no matter how well partitioned, concurrent changes do occur and may require merging.  The amount of merging your team is willing to undertake will therefore be one factor to consider when partitioning your model. Below are some suggestions for determining how much merging your team should be performing:
· Experiment with the Compare/Merge tool to see how it works, how it presents the various contributors, and how different types of changes that you make in the model appear at merge time. Although the first encounter with Compare/Merge and the amount of information it provides can seem intimidating, after using it for a few merges, you will learn how to interpret that information.

· Determine your comfort level with Compare/Merge and then anticipate the comfort level of the other members of the team. Take this comfort level into consideration as you choose your software development strategy.

· As the number of changes between merge sessions increases, the merge sessions are likely to become more complex.

· Merge sessions automatically merge non-conflicting changes. That is, if only one of the contributors to a merge session has changed something, then the merge of that item is likely to occur automatically. However, when more than one contributor has changed a particular item, the resulting conflict must be resolved by the user during a merge session.

Finally, consider the suggestions in the section Model Partitioning Strategy to further guide you in your choice of software development strategy.

Model Partitioning Strategy

Partitioning a model consists of modifying the mapping from model elements to storage unit files. Rational XDE is extremely flexible about how you can decompose a model into files.

Today, developers understand clearly how to partition source code functions and definitions into files in a way that minimizes the amount of concurrent changes required.  Best practices are still evolving for how best to partition model elements for a model-driven development approach that offers similar benefits.  However, careful planning of the mapping of model elements to storage units will make it much easier for a large team to collaborate during the design of a complex system and should not be done in an ad-hoc fashion.

This section offers some advice and suggestions on how to partition your model elements.

Pros and Cons of Model Partitioning

This section describes the benefits and the drawbacks to partitioning a model into storage units. For more information on how to separate and combine model elements, refer to the Rational XDE online Help. See Modeling with Rational XDE Software > Working with Models, Model Elements, and Relationships > Creating, Using, and Modifying Storage Units.

Benefits of Partitioning a Model into Subunits

The size of a model and the desired level of parallelism required by a particular team usually drive this decomposition.

Model Size Considerations Affecting the Partitioning of a Model

When Rational XDE loads a model, it only loads the minimal set of subunits required. Because of this, having a large model partitioned into many subunits will load much faster than the same model stored in a single file.

Development Parallelism Considerations Affecting the Partitioning of a Model

A team working on a particular model will usually partition the model in a way that avoids two team members working on the same storage unit. Since only one person makes changes to a storage unit at one time, there will be no conflicts when the storage unit is delivered. This avoids merges at integration time which, in turn, speeds up the integration process.

Drawbacks of Model Partitioning into Subunits

Although partitioning a model into storage units will decrease the chances of having to perform a merge during integration, there will still be occasions when a merge operation will be required. When these merges do occur, the separation of the model into separate units can make the resulting merge operations a bit more challenging than they would have been had the model occupied a single storage unit. 
Out-of-Context Merging

Because ClearCase merges are always performed one file at a time, only a single model storage unit file can be merged at one time. When delivering an activity, a new Rational XDE Compare/Merge session will start for each individual conflicting storage unit included in the activity’s change set.

Since these merge sessions are done without the context of the other storage units, the validation capabilities of the tool are more limited. Problems can occur because the merge resolutions made during a merge session cannot be validated against other merge resolutions made in a different session for another storage unit of the same model.

Discrepancies between Logical Elements and Their Physical Representation
When renaming or moving a model element which has been made into a separate storage unit file, Rational XDE will neither rename nor move its storage unit file. This can cause unexpected consequences for some operations. For example, let’s assume you have a model with several packages, and the packages and classes are in their own, separate storage units. If you move a class from one logical package (in the Model Explorer) to another logical package, the storage unit file for that class will remain in the directory of its original package. If you were to then perform an operation on the class’s new package directory, such as a ClearCase labeling operation, the operation would not operate on the model element’s storage unit file because it remains in its original package’s folder.

Example

Assume a model named “myModel” is partitioned into two top packages P1 and P2. P1 containing a separated class C1.

The physical layout of the model on the file system is:

C:\Dev\myModel.mdx

C:\Dev\myModel\P1.pkx

C:\Dev\myModel\P1\C1.clx

C:\Dev\myModel\P2.pkx

· Moving C1 from P1 to P2 in the Model Explorer will leave the storage unit files in their original location.

· Renaming C1 to “C2” will not rename C1.clx

Deleting C1 from the model will not delete C1.clx

Rational XDE behaves this way to simplify the management of storage units stored in a configuration management system.

To resynchronize the logical elements and their physical representation:

· Close the model.

· Apply the logical change to the associated storage unit file using the file system viewer (the Navigator in IBM Eclipse or the Solution Explorer in Visual Studio.NET), for example, rename or move the storage unit.

· Reopen the model. A warning message will appear indicating that the original storage unit could not be found.

· In the Model Explorer, select the logical element that you want to resynchronize. Note that the red X overlay indicates the failure to read the storage unit associated with the logical element.

· Right-click and select Browse for Unit….  Select the renamed or moved storage unit. This loads the logical element from the specified storage unit and will update a reference to this file in the parent storage unit. A star (*) appears next to the parent logical element name in the Model Explorer.

Save the parent model element so that the next time the model is loaded, the new storage unit is used.

Balancing the Benefits and Drawbacks of Partitioning Models

As we’ve seen, partitioning a model reduces the time needed to load units, which can be a very important consideration for large models. Also, by choosing an appropriate partitioning, developers will rarely have to work on the same unit at the same time. This will reduce the frequency of merge operations. On the other hand, as you break the model into more storage units, the few merge operations that do occur can face challenges that don’t occur when the model is a single storage unit. For example, the internal validation performed on a unit by XDE during the merge operation can only consider the information present in the unit being merged, and this is now a small part of the entire model. Also, discrepancies can occur between the location of model elements in the model and the location of their storage units in the file system and in ClearCase. 

The balance between few storage units and many storage units will depend on your circumstances. However, few large teams work with a large model in a single storage unit—the benefits of breaking a large model into units generally outweigh the drawbacks. In fact, as the model grows larger, you will want to break it into more storage units. 

When should you decide to break a model into more subunits? This will depend on how successfully you’ve chosen your units, and how independently your developers work. If your subunits are almost completely independent of one another, your will rarely encounter merges and, when you do, the few dependencies between subunits will mean that merging the units separately won’t be very challenging at all. On the other hand, if your units are not very independent, you will find that the merges that do occur will be more difficult. This emphasizes the importance of partitioning a model carefully.
Model Partitioning Guidelines

Candidates for Separate Storage Units

The generally accepted practices for finding subsystems in large systems, such as finding self-cohesive units with low coupling to other units, apply equally well to XDE models. Minimizing the coupling between units reduces the dependencies between them and thus reduces the likelihood that a change in one unit will affect others. Changes in one unit that affect many other units often result in widespread conflicts that need to be resolved in merge sessions. Furthermore, these tend to be out-of-context merges, which can be more challenging to resolve correctly.

When to Separate Storage Units

You should partition a particular abstraction level of a model into subunits when that abstraction level stabilizes. With the abstraction level stabilized, it is less likely that the partitioning will change, which would result in inconsistencies between the logical and physical representation of the model.

Example

During the initial phase of a model lifecycle, only a limited number of designers (often just the architect of the project) will work on the model. The first few versions of the model will depict the top-level subsystems of the system. Until the top-level packages are definitive, and it becomes obvious they will survive future iterations, separating the model into subunits is not recommended. Once the top-level subsystems are mature, separating them should be considered to allow parallel development and to improve the speed at which the model opens. Note that this is a recursive operation. Once each individual subsystem’s contents stabilize, the subsystem itself can be safely partitioned.

Practicing Ownership

To decrease the chances of running into merge sessions during integration of subunits, it is recommended that you practice a storage unit ownership policy. By assigning ownership to the different parts of a model, only owners of a particular storage unit can modify it. Because Rational ClearCase and Rational XDE currently do not provide easy ways to enforce such a policy, a process must be set to accommodate this practice.  Some teams prefer to relax these rules by allowing other team members to modify a storage unit, subject to the approval of the owner.

Precautions when Separating or Combining Model Elements

When separating or combining a model element, it is important to ensure that no other users are modifying this model element in parallel. Otherwise, the model element modifications done by the contributor who is not changing the separate/combined status will be lost.

Example

· Fred and Scott are working on a model that contains a separated package P1 (P1.pkx). This package contains a combined class C1—a class which is not in a separate unit.

· Fred separates C1 to a file named c1.clx. This will require checking out P1.pkx and adding c1.clx to source control. Fred delivers these changes.

· In parallel, Scott changes the documentation of C1. This will require checking out P1.pkx. Scott delivers these changes.

When Scott delivers P1.pkx, the Rational XDE Compare/Merge functionality will properly merge the package. However, the documentation changes made to C1 will not be saved since they should be stored out of P1.pkx, in the now separated C1.clx.

To avoid this situation, Scott should rebase after Fred delivers his changes, and then make the documentation changes to C1, which is now in its own storage unit. If Scott made his changes to C1’s documentation first and then performed a Rebase operation, the merge of the integration stream into Scott’s development stream would suffer the same fate as the example above.
Integrating the Rational XDE Compare/Merge Feature with Rational ClearCase

Rational XDE ClearCase Type Manager Setup

By default, the current release of Rational ClearCase will consider Rational XDE files as standard text files. The compare and merge operations (either directly invoked by the user or used internally during standard ClearCase operations) will therefore use ClearCase’s own text file compare and merge tool, cleardiffmrg. The result of merging XDE Model files using cleardiffmrg will almost certainly be corrupt.

Additional steps must be performed in order to integrate the Rational XDE compare and merge feature with Rational ClearCase. Essentially, the MAGIC_PATH system environment variable and the map file used to determine what merge tool should merge a given file type must be updated. These steps are explained in detail below. They are also described in the Rational XDE online Help. See Comparing and Merging Models > Comparing and Merging Models > Comparing and Merging in ClearCase. However, please note that the XDE 2002.05.00 Help omitted the steps to configure view servers that were not developer workstations.
Note that upgrading to a new ClearCase version or applying a patch may revert some of the following steps. After an upgrade, ensure that the map files and the MAGIC_PATH environment variable still contain the changes specified in the instructions.

In the following examples, we assume that Rational XDE and ClearCase have been installed in C:\Program Files\Rational. If either tool is installed in a different location, please adjust the paths in the examples appropriately.

View Servers

For each view server managing views on a VOB containing XDE files
· Copy C:\Program Files\Rational\XDE\Addins\CompareMerge\cc_xde_unit.magic from a workstation with Rational XDE installed to the view server C:\Program Files\Rational\XDE\Addins\CompareMerge\ directory.
You should create the destination directory if it doesn’t already exist.
Please continue with the steps in the following sections.

Workstations and View Servers

All workstations and view servers that have, or will have, views that will be used to access XDE files must be updated as follows:
1. Add %xde_install_dir%\XDE\Addins\CompareMerge;%cc_install_dir%\ClearCase\config\magic to the MAGIC_PATH system environment variable (create it if it doesn’t already exist),
where
%xde_install_dir% is the installation directory of the Rational XDE software. For example, C:\Program Files\Rational,
and
%cc_install_dir% is the installation directory of the ClearCase software. For example, C:\Program Files\Rational.
2. Append the content of %xde_install_dir%\XDE\Addins\CompareMerge\cc_xde_unit.map to %cc_install_dir%\ClearCase\lib\mgrs\map,
where
%xde_install_dir% is the installation directory of the Rational XDE software. For example, C:\Program Files\Rational,
and
%cc_install_dir% is the installation directory of the ClearCase software. For example, C:\Program Files\Rational.
This will register the XDE compare and merge feature as a ClearCase Type Manager component capable of performing compare and merge sessions. ClearCase will recognize this component as _xde.
3. Reboot the workstation.
VOBs

For each VOB that already contains XDE storage unit files
4. Open the command prompt in view of the VOB and type:
cleartool mkeltype -supertype binary_delta_file -manager _xde -c "Rational XDE files" xde
This creates a ClearCase Element Type for XDE storage units and will associate it with the _xde Type Manager registered above.
5. To verify that the element type is properly installed in the VOB, run:
cleartool lstype -long eltype:xde
The definition of the ClearCase Element Type will appear.
Note that any XDE files created after you have configured the workstation and VOB (as above) will be recognized as ClearCase XDE element types. If you have XDE files that were created prior to the configuration of the workstation and VOB, these files will not be recognized as ClearCase XDE element types. You will need to manually change the element type for these files by running the following command:
cleartool chtype -f xde <filename>
You only need to run the above command for XDE storage unit model files such as .mdx, .clx, .cmx, .obx, and .pkx.
Recommended Settings for Using Rational ClearCase with Rational XDE

When using Rational ClearCase with Rational XDE, we recommend the following settings in the table below.
To access these options in the Rational XDE Professional, Microsoft .NET Edition, click Tools > Options; then, in the Options dialog box, click Source Control > SCC Provider, and then click Advanced…. Note that ClearCase respects the SCC preferences.
To access these options in the Rational XDE Professional, Java Platform Edition, click Window > Preferences; then, in the Preferences dialog box, select Rational ClearCase and click Advanced Options.

	Options
	Description

	Preserve file modified time on checkin

Preserve file modified time on checkout
	Activate these options so that, if you check out a file that is currently open in an editor, you will not be prompted to reload the file from disk because it appears to have changed. This option is highly recommended. 

Note: ClearCase 4.2 and ClearCase LT v.2001.A.04.00 do not display these options; however, the setting is enabled by their latest patches.

	Checkin even if identical
	Activate this option to avoid a “Cannot check in identical files” warning when checking in items for the first time. Note that this warning is harmless (the items are, in fact, checked in), but may cause confusion. However, activating this option can allow you to inadvertently check in an identical version of a file without getting a warning, so choose the setting of this option that best suits you.

	Save copy of file with .keep extension
	Select this option to retain an earlier version of a file that can be helpful in recovery from user error. This option is recommended.


Adding Models to Rational ClearCase

Creating a Source Controlled Project in Rational XDE Professional, Java Platform Edition

To add a model to Rational ClearCase, you must first place the model files into a ClearCase view. The project containing the Rational XDE artifacts must also be stored in the ClearCase view. In the workflows below, a new project is created in a ClearCase view, which will cause you to be prompted to add the project to source control. There is a preference that controls the behavior in such as case and the default behavior is to prompt you as described below. You may also elect to have nothing done, or to have the new resource automatically added to source control without you being prompted.

If you have an existing model or project and want to add it to ClearCase, you’ll need to move it into a ClearCase view and then add it to source control.
· Start Rational XDE.

· On the ClearCase menu, click Connect to Rational ClearCase.

· On the File menu, click New > Project to create a new project that will contain the Rational XDE model.

· Select a Project Type and click Next.

· On the next page, specify a project location folder within the desired ClearCase view. You will need to uncheck the “Use default location” and then browse to the location of your view. Do not use the default location. 

Note: Select a subfolder within the view’s root as opposed to the root folder itself. This subfolder will contain your project artifacts. If you haven’t yet created a subfolder in the view to hold your project, you can browse to the view’s root directory in the dialog box and then simply append the name of a subfolder to the resulting path.
· When the New Project dialog box closes, you will be prompted to add the folder associated with the project to ClearCase (if it is not already in ClearCase). 

Any new resource contained in this project, such as a Rational XDE model, will automatically be added to ClearCase.

Creating a New Rational XDE Model in a Project under Source Control

· On the File menu, click New > Model to create the new model.

· In the New XDE Model dialog box, ensure that the Destination Folder field is set to a folder associated with, or contained in, a source controlled project (created as described in the preceding section).

· When the New XDE Model dialog box closes, you will be prompted to add the model to ClearCase. 

· You will be prompted to add any new storage unit created within Rational XDE to ClearCase when you save for the first time.

When performing a code generation operation and the source file destination directory is in a source controlled project, generated source files will automatically be added to ClearCase.

Creating a Source Controlled Project in Rational XDE Professional, Microsoft .NET Edition

To add a model to Rational ClearCase, you must first place the model files into a ClearCase view. The project containing the Rational XDE artifacts must also be stored in the ClearCase view. In the workflows below, a new project is created in a ClearCase view and then it is added to source control, which places it in the VOB. 
· Ensure that Rational ClearCase is the current source control system used by Visual Studio .NET.

Note: You can verify this by checking the registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\SourceCodeControlProvider

Ensure that the value name ProviderRegKey is associated with the value data Software\Atria\ClearCase. 

· Start Visual Studio .NET.
· Create the project that will contain the Rational XDE model. Ensure that it is located in a ClearCase view.  Most users prefer to select a subfolder within the view’s root as opposed to the root VOB folder itself.

Note1: The Visual Studio .NET project type selected will affect the user experience. In the Rational XDE online Help, see Working with Models Under Source Control > Understanding Configuration Management of Models > Overview of Configuration Management of Models.

Note2: The Miscellaneous Files Project does not support source control.

· On the File menu, click Source Control > Add Solution to Source Control to add the solution to source control. Many activity and/or warning dialog boxes about the creation of identical versions may appear depending on your ClearCase settings. Click OK to all of these dialog boxes.

Any new resource contained in this project, such as a Rational XDE model, will automatically be added to ClearCase.

Creating a new Rational XDE Model in a Project under Source Control

· Select the project and/or solution that you want to own the new model.

· On the File menu, click Add New Item to create the new model.

· Select a template from the Rational XDE category.

Note: Although Visual Studio .NET displays a check out icon beside the model, it is not actually added to source control until it is checked in for the first time.
When performing a synchronization operation and the source file project is in a source controlled project, generated source files will automatically be added to ClearCase.

UCM Workflows for RTE Artifacts

The two main UCM workflows involve the Deliver and Rebase UCM operations. The following subsections describe the workflows that we recommend when working with Rational XDE Round-Trip Engineering (RTE) artifacts.

In general, users should perform a Rebase operation before a Deliver operation. This ensures that the changes to be delivered to the integration stream are based on the most recent recommended baseline. Although the Rebase operation itself can trigger merge sessions, it will generally result in easier merge sessions during the Deliver operation because two smaller sets of merge sessions are generally easier to perform than one larger set of merge operations.
Workflow for Delivering RTE Artifacts

When delivering UCM activities containing Rational XDE RTE artifacts, we recommend the workflow described in this section. Note that, as is generally recommended for UCM, you should perform a Rebase operation before performing a Deliver operation. The workflow for Rebase is described following this section.
Workflow Steps

· Synchronize the RTE artifacts from within the development view.

· Check in all model and code artifacts. 

· Perform the first part of the UCM deliver operation, merging if required.

· Open the model from within the integration view, and validate and fix any merge errors. Check out additional files as required.

· Synchronize the RTE artifacts from the integration view. Check out additional files as required. Validate by rebuilding.

Complete the delivery.

Synchronize in the Development View

Synchronizing before delivering will ensure consistency in the development stream and thus help to ensure consistency in the integration stream. This is critical because delivering a change that is itself inconsistent will cause problems in the overall project. Note that synchronizing before delivering will make the subsequent steps easier to perform.

Check in all Model and Code Artifacts

All artifacts to be delivered must be checked in. This is a normal UCM procedure.

UCM Deliver and Merge

Next, you should perform the first part of the UCM Deliver operation. This step may involve merging code and/or model artifacts. You should ensure that consistent decisions are made when resolving conflicts that occurred when merging the different artifacts. Otherwise, you can end up with inter-unit consistency errors or model/code consistency errors. Please see the sections in the Merging Models section of this document.
Fix Merge Errors in the Integration View

Open the model from within the integration view. Validate the model and fix any merge errors. Check out additional files as required. This allows you to fix any problems that could be the result of inconsistent merge decisions. It is the opportunity for the user performing the delivery to validate all storage units of the merged model in the same context. For more information, see Out-of-Context Merging.

Synchronize in the Integration View 

Synchronize the model and code in the integration view. You may need to check out additional files if changes result from the synchronization operation. Once finished, you should validate your application by rebuilding. This provides the compiler and the linker with the opportunity to find any errors that may have occurred so far.
The individual merge of model and code artifacts can result in desynchronizing the model and code artifacts. For this reason, it is important to resynchronize the code artifacts prior to completing the delivery. 

Note: The synchronization may cause artifacts to be checked out of the integration stream. By completing the delivery, the artifacts will be checked back in.

Complete the Deliver Operation
This is the final step. At this point, the integration view contains a consistent model with synchronized code and model artifacts. All modified files are checked out and can be checked in by ClearCase through the Deliver operation.

Workflow for a Rebase of RTE Artifacts

When rebasing UCM activities containing Rational XDE RTE artifacts, we recommend the workflow described in this section.

Workflow Steps

· Synchronize the RTE artifacts from within the development view.

· Check in all model and code artifacts. 

· Perform the first part of the UCM rebase operation, merging if required.

· Open the model from within the development view, and validate and fix any merge errors. Check out additional files as required.

· Synchronize the RTE artifacts from the development view. Check out additional files (as required). Validate by rebuilding.

Complete the rebase.

Synchronize in the Development View

Synchronizing before rebasing will ensure consistency in the development stream and will therefore make the subsequent steps easier to perform.

Check in all Model and Code Artifacts.

All artifacts to be rebased must be checked in. This is a normal UCM procedure.

UCM Rebase and Merge

Perform the first part of the UCM rebase operation, merging if required. This may involve merging code and/or model artifacts. You should ensure that consistent decisions are made when resolving conflicts while merging the different artifacts.

Fix Merge Errors in the Development View

Open the model from within the development view, and validate and fix any merge errors. Check out additional files as required. This allows you to fix any problem that could be the result of inconsistent merge decisions. It is the opportunity for the user performing the rebase to validate all storage units of the merged model in the same context. For more information, see Out-of-Context Merging.

Synchronize in the Development View

Synchronize the model and the code in the development view. You may need to heck out additional files when you perform the synchronize operation. Then, validate the source code by rebuilding, which includes compiling and linking. The compiler will help to find any errors that may have occurred so far.
The individual merge of model and code artifacts can result in desynchronizing the model and code artifacts. For this reason, it is important to resynchronize the code artifacts prior to completing the delivery. 

Note: The synchronization may cause artifacts to be checked out of the development stream. By completing the rebase, the artifacts will be checked back in.

Complete the Rebase Operation
This is the final step. At this point, the development view contains a consistent model with synchronized code and model artifacts. All modified files are checked out and can be checked in by ClearCase through the rebase operation.

Merging Models

Merging code is not a trivial experience. It requires a good understanding of the system with the code that requires merging, and a good understanding of the language in which it is written. The Rational XDE Compare/Merge functionality is similar; it requires a good understanding of the artifact being merged, of the model, and of UML.

Resolving Conflicts in a Consistent Manner

When you perform Rebase and Deliver operations, you may be involved in many separate merge sessions to resolve the conflicts. As you do so, you must ensure that you resolve conflicts in a consistent manner across all of these merge sessions. For example, a conflict occurring because two users chose different names as the new name of a method may result in many conflicts in the code and model across many sessions. Choosing one user’s new name for some conflicts and the other user’s new name for the same method for other conflicts will cause inconsistencies within the model and between the model and the source code.
Inter-Unit Consistency Errors

Inter-unit consistency errors may occur when resolving two related conflicts found in different storage units. 

Example

Two users, U1 and U2, are working on a model partitioned into two top packages, P1 and P2, each separated.  P1 contains class C1 and P2 contains a diagram showing C1.

· U1 deletes the C1.

· U2 user renames C1.

· U1 delivers his/her changes without needing any merge.

U2 delivers and gets two separate merge sessions, one for each package.

When merging P1, U2 must resolve a delete-change conflict for Cl. When merging P2, U2 must also resolve a delete-change conflict for the view of C1. To keep the model consistent, U2 should make coherent decisions. Deleting C1 from P1 and keeping the view of C1 in P2 would result in an unresolved reference.

Mode/Code Consistency Errors

Model/code consistency errors may occur when resolving two related conflicts; one found in a storage unit and the other in the source file. 

Example

Two users, U1 and U2, are working on a model containing a class C1 with an operation foo(). The model is kept synchronized with a source file c1.java containing the implementation of foo() in class C1.

· U1 deletes foo() in class C1 and synchronizes c1.java. 

· U2 renames foo() in class C1 to bar() in class C1 and synchronizes c1.java.

· U1 delivers changes without needing any merge.

U2 delivers and gets two separate merge sessions: one for the storage unit containing class C1, and the other for the source file c1.java.

When merging the model storage unit, U2 must resolve a delete-change conflict for foo() in class C1. When merging the source file c1.java, U2 must also resolve a delete-change conflict for the implementation of foo() in class C1. To keep the model consistent, U2 should make coherent decisions. Deleting foo() in class C1 from the model and renaming the implementation of  foo() in class C1 in the source file would result in an inconsistency between the model and the code.

Rational XDE Elements Specific to Compare and Merge

This section describes the XDE model elements that are typically seen only during a Compare/Merge operation. That is, you are unlikely to see these elements in the Model Explorer, typically because they represent elements on a diagram and are filtered out of the display in the Model Explorer. These descriptions will help you to better understand the items you see in the various explorers specific to the Compare/Merge operation.
Views Elements

As defined by the UML standard, a model element representation within a diagram is the instantiation of another model element called a view element (this is not the same as a ClearCase view element). The diagram they are shown in owns the view elements. They refer to the model element they represent by a property named “ModelReference”.

A shape in a diagram is actually composed of a top view element that is composed by the other sub-views that it owns.

Example

A shape representing a class in a diagram is actually a PositionalGeneralView that is composed of a SubShapeView. The SubShapeView can contain a NameCompartmentView that holds the name of the viewed model element, a first ListCompartmentView for attributes and a second one for operations.

The following table shows the view related model elements appearing in the Comparative Model Explorer that do not appear in the Model Explorer.

	Element Kind
	Icon
	Description

	ActiveX View
	
[image: image1.png]



	Represents an ActiveX component

	Swim Pool View
	
[image: image2.png]



	Represents a swim pool that contains swim lanes on an activity diagram

	View Element
	
[image: image3.png]



	Represents a view element. Displayed as an overlay above the UML icon of the viewed model element.

	Workspace Element
	
[image: image4.png]



	This is an element that represents the collection of information about a workspace. For example, it might be a list of the windows that were open and their placement at the time that the workspace was closed.


Profiles and Tagged Value Sets

Rational XDE annotates model elements with UML Tagged Values. These tagged values let Rational XDE associate information to UML model elements. UML Tagged Values are used in many placed in Rational XDE. Among others, they are used to store view element style information as well as information specific to features such as Java and Patterns.

Tagged values are grouped together to form a set of tagged values (TaggedValueSet). Each UML model element has a property named “TaggedValueSetReference”. This property contains a collection of references to TaggedValueSets.

TaggedValueSets can contain other TaggedValueSets. They can be owned by any other UML model elements. Most TaggedValueSets are found in a TaggedValueSet named “Profile”, owned by the root model element.

The following table shows the profile related model elements shown in the Comparative Model Explorer that do not appear in the Model Explorer.

	Element Kind
	Icon
	Description

	Blob Tagged Value
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	A tag value of type “binary”

	Boolean Tagged Value
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	A tag value of type “boolean”

	Enumeration Tagged Value
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	A tag value of type “enumeration”

	Expression
	
[image: image8.png]



	A string containing an expression

	Integer Tagged Value
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	A tag value of type “integer”

	Mask Tagged Value
	
[image: image10.png]



	A tag value of type “mask”

	Profile
	
[image: image11.png]



	A collection of tag value sets that each have tag definitions and tag values that collectively make up a profile related to some domain

	Real Tagged Value
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	A tag value of type “real”

	References Tagged Value
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	A tag value whose type is a collection of references

	Reference Tagged Value
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	A tag value whose type is “reference”

	String Tagged Value
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	A tag value whose type is “string”

	Tag Definition
	
[image: image16.png]



	A definition for a tag value

	Tagged Value Literal
	
[image: image17.png]



	An enumeration consisting of a set of literals. So, a tagged value literal element defines one of the values that an enumeration can hold.

	Tagged Value Set
	
[image: image18.png]



	This is a set of tag definitions and tag values

	Type Expression
	
[image: image19.png]



	An expression that describes the type of an attribute or parameter that is not a simple type. For example, “*window” is an expression that means “pointer to some object of type ‘window’”


Styles

The following table shows the model element for styles that appears in the Comparative Model Explorer but does not appear in the Model Explorer.

	Element Kind
	Icon
	Description

	Style
	
[image: image20.png]



	Style Definition


Association Elements

	Element Kind
	Icon
	Description

	Association End
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	An association end is one of the ends of an association that holds properties specific to that end, such as navigability

	Association Role
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	This is an association within the context of a specific collaboration


Actions Model Elements

Action model elements typically appear on sequence diagrams. 
	Element Kind
	Icon
	Description

	Create Action
	
[image: image23.png]



	An action that results in the creation of an object

	Destroy Action
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	An action that results in the destruction of an object

	Message End
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	One end of a message

	Return Action
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	The action that occurs when a called operation returns a value to the caller

	Send Action
	
[image: image27.png]



	The action that results in the sending of a signal to some object

	Terminate Action
	
[image: image28.png]S




	A terminate action is  the act of an object destroying itself


Merge Granularity

The Rational XDE Compare/Merge capability does not merge the content of a model element property. For this reason, you may wish to avoid modifying, in parallel, properties such as the model element documentation. Otherwise, the integrator will need to pick one of the modified versions and then manually modify the property to incorporate the changes from the other modified version without assistance from the Compare/Merge capability.

Conclusion

This paper has described the issues to consider, and guidelines to follow, when using XDE with ClearCase UCM. Armed with this understanding, you should be able to choose a software development approach and model partitioning strategy that is right for your team.
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